
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

I-Prop 

User‘s Guide 

 version 1.3r.104 



 

 

U S E R ‘ S  G U I D E  

I - Prop 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 Pavel Pechač 
info @ i-prop.cz 

http://www.i-prop.cz 



 

 3 

Contents

 

1  Introduction 4 

2  Installation 5 

3  I-Prop User Interface 6 

3.1 Structure of Prog. Win. 6 

3.2 Info  Window 7 

3.3 Mirror Plot  Window 7 

3.4 Menu 8 

3.5 Toolbar 9 

4  Projects 10 

4.1 Project Files 10 

4.2 Edit Building Dialog 11 

4.3 Model Param. Dialog 13 

4.4 Device List Dialog 14 

4.5 Antennas Dialog 15 

4.6 Scales Dialog 16 

4.7 DXF Import Dialog 17 

5  Floor  Plan Mode 19 

5.1 Info Window 20 

5.2 Tools 20 

6  System Plan Mode 22 

6.1 Info Window 23 

6.2 Tools 23 

6.3 BS Parameters Dialog 24 

7  Prediction Mode 25 

7.1 Prediction Menu 26 

7.2 Info Window 27 

7.3 Tools 27 

8  Line Plot Mode 28 

8.1 Line Plot Menu 29 

8.2    Info Window 29 

9  Propagation Prediction Models 30 

9.1 One Slope Model 31 

9.2 Multi - Wall Model 33 

10 How to Create a New Project 34 

 



I N T R O D U C T I O N  

 4 

1 Introduction 

I-Prop is a software tool for an interactive planning of 3D picocellular wireless 
systems inside multi-floored buildings. Using indoor propagation models I-Prop 
provides various types of signal coverage analysis. The straightforward concept of 
the software tool assures an efficient design of indoor wireless systems for wide 
range of users.  
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2 Installation 

Brief  description of  I-Prop software installation. 

Copy the I-Prop directory (or extract it from a ZIP archive) to a desired place on 
your HDD. To uninstall it just simply delete it. I-Prop does not use any files 
outside its directory, nor the Registry. 

System requirements 

MS Windows 9x/NT/2000/XP/Vista/7, RAM and HDD according to a project 
extent 

Demo version 

 run I-Prop.exe 

Full version with hardware key 

 insert a hardware key into an USB port 

 run hdd32.exe to install a driver for the hardware key and follow instructions 
(use the same procedure for uninstall) 

 run I-Prop.exe  

WARNING! 

The hardware key must be properly inserted into the port while 
running I-Prop software! Otherwise, undefined errors can 
occur. 

Subdirectories of installation 

 Doc - documentation in PDF format 

 Models - parameter files for propagation models 

 Examples - sample project files 

 Scales - alternative color scales. 
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3 I-Prop User Interface 

Introduction to user interface, main window, menu, etc.  

For effective and transparent work the I-Prop user interface is divided into five 
operational modes. In each mode various tools can be selected for a specific action. 
Together with the change of the mode other controls (menu, toolbar) and 
information in current windows are changed accordingly. 

 

 

3.1 Structure of Program Window 

The window of I-Prop can be divided into three parts (except title bar, menu and 
bottom status bar): 

 Left part - optionally Info or Mirror Plot window (see below). 

 Right part - Main window - with switch of operational modes at the top. 
Graphical information of the main window is different for each mode (see 
below). 

 Toolbar - some menu commands, current floor selector and tool switch 
(see below). 

Main 
window 

Switch of 
operational 
modes 

Mirror Plot 
window 

Info window 

Tool 
selection 

Toolbar 
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3.2 Info  Window 

Info window contains text information connected 
to a picture in the main window. There are four 
sections: 

Cursor coordinates 

The current cursor position coordinates in meters 
are in the first two lines. X,Y position is given both 
absolutely and relatively to auxiliary coordinate 
origin (separated by ‘/’). 

The position of auxiliary coordinate origin together 
with its distance to cursor position is on the third 
line. Using check box a view of the auxiliary origin 
in the main window can be switched on/off (as in 
the menu View - Auxiliary [X,Y] Origin). 

Text description 

Information connected to the current mode and 
selected tool - see below the modes descriptions. 

Legend 

Information connected to the current mode - see below the modes descriptions. 

Quick Tips 

Brief help/tips, which is automatically changed according to the selected mode and 
tool.  

3.3 Mirror Plot  Window 

Using the menu command View - Set Mirror Plot the picture from the main window 
is copied to the Mirror Plot window. The picture doesn’t change with a mode and 
cannot be edited. Using the Mirror Plot window two different pictures can be 
viewed and compared in parallel according to user needs. 
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3.4 Menu 

File 

 New - creates a new empty project 

 Open… - opens an existing project 

 Save… - saves a current project 

 Save As… - saves a current project with a new file path 

 Print - prints the picture from the main window 

 Print Setup… - sets the printer options 

 Export Bitmap… - saves the picture from the main window as a bitmap 

 Exit - ends the I-Prop 

View 

 Background Bitmaps - switches on/off background bitmaps in the main 
window picture 

 Walls - switches on/off  the walls in the main window picture 

 Grid - switches on/off  the grid in the main window 

 Auxiliary [X,Y] origin - switches on/off  the Auxiliary origin in the main 
window 

 Set Mirror Plot - copies a current picture from the main window to the 
Mirror Plot window 

 Set Grid - sets the grid density 

 Scales… - starts the Scales dialog (see below) 

 Zoom out - sets to zoom so that a floor plant fits to the main window 

Project 

 Building… - starts the Edit Building dialog (see Ch. 4.2) 

 Model Parameters… - starts the Model Parameters  dialog (see Ch. 4.3) 

 Device List… - starts the Device List  dialog (see Ch. 4.4) 

 Antennas… - starts Antennas dialog (see Ch. 4.5) 

About 

 author and version information 
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3.5 Toolbar  

 

There are three groups of controls on the toolbar: 

 buttons equivalent to menu commands: 

 open project, File -Open… 

 save project, File - Save… 

 print main window, File - Print… 

 copy main window picture  to Mirror Plot window, View - Set 
Mirror Plot 

 run the whole building prediction calculation, Prediction - Run 
Building in Prediction mode 

 list of all floors in the building - fast floor navigation 

 tool selection buttons, which are different for each mode (see below). 
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4 Projects 

Project structure, dialogs to work with a project. 

4.1 Project Files 

All necessary information for the design of 3D picocellular network is stored in a 
form of a project. The are four data files composing the project which must be in 
the same directory. The have a same file name but different extension: 

*.ipp - main project file 

*.mp -  parameters for prediction calculation 

*.bws - floor plans 

*.dev - database of antennas and base stations. 

When saving the project backup copies of previous version files are created adding 
‘bak’ to the file extensions. 

When background bitmaps are used the bitmap files are also part of the project, 
but they are not stored using Save or Save As commands. When moving the project 
files the bitmap files must be moved manually and appropriate paths in the Edit 
Building dialog must be updated (see Ch. 4.2). 

Files with measured data in *.md? format are not part of the project. 
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4.2 Edit Building Dialog 

The Edit Building dialog for a basic editing of building floors is in the beginning of 
all new projects. The dialog can be divided into several sections: 

 

Building - floors 

 Floor list - list of all defined floors of the building. Editable parameters of 
selected floor are available in the Floor section (on the right-hand side). 

 New - inserts a new floor. The floor list is always continuous, so, e.g., if 
new floors numbered 5 and 10 are inserted, floors numbered 6, 7, 8 and 9 
are added automatically. Maximum number of floors is limited to 64. 

 Delete - removes selected floor. 

 Copy - copies selected floor settings to clipboard. 

 Paste - inserts a floor from clipboard (stored by Copy command). 

 DXF Import - imports a new floor from a DXF file (AutoCAD format) - 
see next chapter. 

 Renumber - changes a floor numbers. 
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Floor 

Parameters of selected floor can be edited in subsections. Number of walls defined 
within the floor and X, Y dimensions are indicated at the section bottom. 

Height 

 height of the floor in meters including ceiling thickness 

 To All - copies the height to all floors. 

View 

 sets the viewport of the floor for the main window and all the predictions 

 x1, y1 - coordinates of the left bottom corner in meters 

 x2, y2 - coordinates of the right top corner in meters 

 Auto - automatic viewport calculation so that the background bitmap and 
all defined walls are inside it. 

 To All - copies the view subsection parameters to all floors. 

Background Bitmap 

 file path to background bitmap (Windows BMP file) 

 Browse - sets the bitmap file path 

 x0, y0 - position of left bottom corner of the bitmap in X, Y coordinate 
system (in meters) 

 width - real width of the bitmap in meters (defines the scale of the bitmap) 

 Auto [0,0] - automatic calculation of x0, y0 - the bitmap will be moved in 
X, Y systems so that the bitmap point indicated by auxiliary origin 
placement becomes a [0,0] X, Y coordinate origin. (The usage is 
demonstrated in the Chapter 11.) 

 To All - copies the background bitmap parameters to all floors. 

 

WARNING! 

When moving project files the background bitmap files and the file 
path to them are not automatically updated.  
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4.3 Model Parameters Dialog 

A multiple page dialog to set the prediction calculations parameters. The Model 
page contains common parameters, which are described in this chapter. Other 
pages are attached to specific prediction models, which are described in Ch. 10. 

 

Model 

 The prediction model selection. 

 Multi-floor propagation - when not checked the propagation of the signal 
through the floor/ceiling is not considered. 

Freq. Range 

 Frequency range of the model parameters validity (lower f min and upper f 
max limits in MHz). When the frequency of a base station is out of the 
range a warning message is shown before every prediction calculation. 

Coverage 

 Pmin - power level limit required for system coverage in dBm (receiver 
sensitivity). 

Grid analysis step 

 step in meters for coverage analysis - spacing of calculation points. The 
step and building dimensions determine the number of points where the 
prediction is calculated. This number also determines the time and memory 
requirements for calculations. In all predictions the coverage is 
calculated for the height of 1.5 m above the floor. 

Model Parameters 

 text description of model parameters file. 

 Load/Save - loads/saves the parameters from/to *.mp file. 
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4.4 Device List Dialog 

Dialog for tabular list of bas stations. 

 

 Using mouse the columns positions and widths can be changed. 

 Using mouse the rows positions together with base station indexes can be 
changed. 

 The base station parameters can be edited in the table. The antenna is set 
by its name. In the case of nonexistent antenna the isotropic radiator is 
used instead. The parameters can also be edited in the Base Station 
Parameters dialog, see Ch. 6.3. 
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4.5 Antennas Dialog 

The dialog to an edit antenna database which is stored together with base stations 
in *.dev project files. 

 

Available antennas 

 List of all antennas in the project. 

 Delete - removes selected antenna. First two fixed antennas (Isotropic a 
Hemispherical) cannot be removed. 

 New - creates a new antenna. 

Antenna parameters 

 Selected antenna parameters, which are different for different antenna 
types. Editing of the first two fixed antennas is limited. 

 Name - name of the antenna. 

 Type - the antenna type. 

 antenna parameters according to the antenna type 

 Gain - max. antenna gain in dBi. 

 Side lobes - side lobes in dB relatively to the main maximum of the 
antenna radiation pattern. 

There are two antenna types in version 1.0: 

 Isotropic - the isotropic radiator with 0 dBi gain. 

 Hemispherical - the idealized hemispherical radiator with the gain of Gain 
in the hemisphere of the main maximum direction and the gain of Gain - 
|Side lobes| in the opposite hemisphere. 
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4.6 Scales Dialog 

The dialog to customize color scales for a coverage analysis (menu Project - Scales). 

 

On the left there is a color scale for base station index/freq. channel. On the right 
there is a power level color scale in dBm (RSSI Scale) or an error scale in dB (Error 
Scale). For these scales their lengths (number of colors) and appropriate limits 
(numbers in descending order) can be edited. Last limit for Error Scale is always -
999 dB. The colors can be changed when clicking on the color field. 

 Continuous - a continuous scale for the RSS Study (see Ch. 7). 

 RSSI Hatching - an indication of the signal strengths in the Best Server and 
Freq. Channel studies (see Ch. 7).  The color indicating appropriate BS index 
or a channel number is graded according to the signal strength down to 
white color. The signal strength maximum (selected color in the dialog) 
and the minimum (white color) are set by the first and last limits of the 
RSSI Scale. 

The scales can be saved or loaded as a file (buttons Load and Save). On the I-Prop 
startup scales from default.clr file in the program directory are automatically loaded. 
Current scales are automatically saved to this file when closing the program. 
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4.7 DXF Import Dialog 

The DXF Import dialog is launched from Edit Building dialog to import a floor from 
a DXF AutoCAD file, which has to be selected first. Professional building plans 
are quite intricate and correct building plan divides floors into different drawing 
layers. That is why the import is executed only for single floor at a time. For multi-
floored buildings the procedure has to be repeated for each floor. 

The procedure using the dialog (described bellow) can be divided into 4 steps: 

 Drawing layers and corresponding wall type are selected. 

 The number and height for the new floor is selected. 

 The transformation is run. 

 If successful, the new floor is inserted into a building plan. 

Table of DXF Drawing Layers  

 Layers - list of layer names included in the selected DXF file. 

 on/off - AutoCAD flag (no influence on the import). 

 Freeze - AutoCAD flag (no influence on the import). 

 Accept - indicates whether the layer is selected for the import. 

 Light, Heavy, Def. 1, Def. 2 - wall types used in the I-Prop Multi-Wall 
Model. Double-click a grid element to accept a layer as the desired wall 
type. 

Name of Imported 
DXF File 

Table of 
Drawing 
Layers 

Transform. 
Messages 

Tables of 
Extents 



P R O J E C T S  

 18 

 Entities - Number of entities within the layer. 

 Xmin, Xmax, Ymin, Ymax, Zmin, Zmax: - Extents of the layer. 

Tables of Extents 

 Drawing Extents - overall extents of the drawing (original from 
AutoCAD) 

 Accepted Layers Extents - overall extents of all layers accepted for the 
import. 

 Accepted Entities - Total number of all entities within the accepted layers. 

Transform. Messages 

 Information generated by import procedure run by Transform button. Also 
indicates the total number of degenerated and negligible (smaller then 
10mm in XY plain) entities. 

Output Floor Settings 

 Floor Number - floor number of the imported floor. 

 Floor Height - indicates the height for the imported floor. The number in 
gray box is calculated from Z extents of accepted layers as a hint (double-
click it to accept this value as a floor height). 

 Transform - The button is enabled only if the total number of accepted 
entities is nonzero. 

 Created Walls - information about a total number of created walls within 
the new imported floor plan. 

 

Import 

 Inserts the new floor plan to the building. If a floor with the same floor 
number already exists, all the existing floors are shifted up. The Transform 
must be pressed first. 

 

Useful Tips 

 Select only layers, which you want to import and assign each of them one 
of the wall types. 

 The import procedure accepts only DXF entities of the type "LINE". 
Almost all the important entities for walls description can be simply 
converted to LINE type by AutoCAD function "Explode".  

 The extent of a floor plan in I-Prop is than same as it was in AutoCAD. A 
scale of DXF drawing is expected in millimeters. If not, use  Rescale in the 
toolbar to change the scale of the floor plan (see Ch. 5.2). 
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5 Floor  Plan Mode 

In this operational mode the floor plan is view and edited. 

 

In the main window the floor plan of the current floor is showed. First the 
background bitmap is drawn (if defined in the Edit Building dialog for the floor). 
Then the walls, partitions and holes (if defined) are painted. The thickness and 
color for the walls is assigned according to wall types (see legend in the Info 
window). For holes, red rectangles with diagonal are used. 

Currently selected wall (hole) has emphasized ends (corners). 

In the View menu the display of background bitmaps can be switched off. The 
walls are always visible in this mode. 

In the View menu the visibility of the grid and auxiliary origin can be switched 
on/off. The blue color is used. 

White color of a background bitmap is transparent for other displays 
in the main window (walls, grid, coverage analysis etc.). That is why 
the background bitmaps should be simple pictures with prevailing 
white. Otherwise, the final image will be too complicated to 
comprehend. 
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5.1 Info Window 

Cursor coordinates 

See Ch. 3.2. 

Text description 

Coordinates of the selected wall corners. The wall 
lengths in meters. 

Legend 

Legend for wall types. The text description is set by 
the Multi-Wall model parameters (the Model 
Parameters. dialog). The type of the selected wall is 
emphasized. 

Quick Tips 

See Ch. 3.2. 

5.2 Tools 

 Info 

The wall (hole) is selected by a left mouse click on it (on hole’s diagonal).  

 Zoom 

Zoom in - dragging a rectangle with a mouse toward down/right (left mouse 
button pressed). The maximum zoom is limited. Zoom out - fit the image to the 
window - dragging a rectangle in the opposite direction (up/left). The viewable 
sector of the floor plan can be set in the Edit Building dialog. 

 Rescale 

Right click sets the auxiliary coordinate system origin position. The visibility of the 
origin in the main window can be set in the View - View auxiliary [X,Y] origin menu 
or in the Info window. 

All floor plans of the building can be rescaled by drawing the line with the left 
mouse button and assigning real length of the line in meters. The positions of base 
stations of the project are recalculate as well. 

Holding keys when drawing: Ctrl - snap to corners, Shift - horizontal/vertical lines 
only, Alt - snap to grid. The grid can be set in the View menu. 

 New Wall 

Using a mouse a new walls can be added to the floor plan. The function of Alt, 
Shift and Ctrl keys while drawing is described above. The wall type is determined by 
a selection in the legend in the Info window. 
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 Edit Wall 

In the legend of the Info window the wall type of selected wall can be changed. The 
wall corners can be repositioned using a mouse. The function of Alt, Shift and Ctrl 
keys while drawing is described above. 

Similarly a hole can be selected and edited using its diagonal. 

Delete key removes the currently selected wall (hole). 

  New Hole 

New rectangular holes can be added to the floor plan using a mouse. The function 
of Alt, Shift and Ctrl keys while drawing is described above. 

 

 



S Y S T E M  P L A N  

 22 

6 System Plan Mode 

The base station picocellular system can be viewed and edited in this 
operational mode. 

 

In the main window the base stations are shown with a floor plan in the 
background. Visibility of the floor plan background bitmaps and walls can be set in 
the View menu as well as the grid and auxiliary coordinate system origin. All the 
walls are drawn in black color. 

A base station is shown as a circle for an omnidirectional antenna and as a half-
circle for directional antenna. 

The color is defined by the base station index and can be edited in Scales dialog (see 
Ch. 4.6). 

Base stations from other than the currently displayed floor are shown in a reduced 
size. 

Base stations, which are switched off, are crossed. 
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6.1 Info Window 

Cursor coordinates 

See Ch. 3.2. 

Text description 

Currently selected base station information: name, 
floor number, location (X, Y, height), power in 
dBm, antenna. 

Legend 

List of all base stations in the project: switched 
on/of, index, floor number, name. Base stations 
can be directly switched on/off from the list. The 
selected base station is emphasized. 

Quick Tips 

See Ch. 3.2. 

6.2 Tools 

 Info 

Mouse left click selects the base station. 

Using the right mouse button the base station can 
be repositioned. 

Right click on a base station copies its parameters into the memory. These 
parameters are then used as a default values for new base stations.  

Double click on a base station runs the Base Station Parameters  dialog (see below). 

 Zoom 

See Ch. 5.2. 

 Rescale 

See Ch. 5.2. 

 New BS 

Left click adds a new base station at the mouse position. The Base Station Parameters 
dialog (see below) for the new base station is launched. 
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Right click changes the azimuth of a directional antenna (Hemispherical) for a new 
base station to all quarters and downwards (antenna mounted on a ceiling). The 
direction is indicated by a cursor shape. 

Delete key removes the selected base station (in all tools). 

6.3 Base Station Parameters Dialog 

 

 Description - text description - name - of the base station. 

 Location - floor number, X, Y coordinates and a height above the floor. 

 Power - transmitter power in dBm (at the antenna input). 

 Antenna - name, azimuth and elevation of the used antenna.  

 Frequency channel – frequency in MHz and the frequency channel 
number. 
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7 Prediction Mode 

The coverage studies are calculated and viewed in this operational mode. 

 

In the main window a selected coverage study is shown with a floor plan in the 
background. Visibility of the floor plan background bitmaps and walls can be set in 
the View menu as well as the grid and auxiliary coordinate system origin. All the 
walls are drawn in black color. 

Color scale for the study is displayed in the Info window. All the scales can be edited 
in the Scales Dialog (see Ch. 4.6). 

The analysis step (editable in the Model Parameters dialog) determines the square size 
in a grid for analysis calculations. The computed value (color) corresponds to the 
center point of the square. 

The analysis step determines the number of points for prediction 
calculations and study picture drawing. That is why this parameter has 
an essential influence on the calculation and drawing time and on the 
memory requirements. 
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7.1 Prediction Menu 

 Run building (F9) - runs the prediction for all floors of the building. 

 Run floor (Ctrl F9) - runs the prediction calculation only for the current 
floor. 

 RSS (F4) - the received signal strength (by isotropic antenna) study - 
displays the maximum signal strength. 

 Best Server (F5) - the best server base station study - using the index color 
the base station with the strongest signal in the point is indicated.  

 Freq. Channel (F6) - the best server frequency channel study - using the 
index color the frequency channel number with the strongest signal in the 
point is indicated.  

 Coverage (F8) - if checked the locations with signal strengths lower than 
the limit defined in the Model Parameters dialog (no coverage) are filled 
white. 

 Export - export of the RSS coverage study in the ‘measured data’ file 
format - see Ch. 9.1. 
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7.2 Info Window 

Cursor coordinates 

See Ch. 3.2. 

Text description 

Analysis information for the cursor position (RSS, 
best server index, and best server frequency channel) 
or an information on a last segment of a polyline 
path when the Set line plot tool is selected (see below). 

Legend 

Color scale for the selected coverage analysis (e.g. 
received power in dBm, base station index or 
frequency channel number). 

Quick Tips 

See Ch. 3.2. 

7.3 Tools 

 Info 

In the Info window the analysis information for the cursor position is displayed. 

 Zoom 

See Ch. 5.2. 

 Rescale 

See Ch. 5.2. 

 Set line plot 

Dragging a line using left mouse button, a new polyline path for the Line Plot mode 
is created. Left click adds a point to the polyline path. Maximum number of points 
is 16. Information for the last section is displayed in the Info window.



L I N E  P L O T  

 28 

8 Line Plot Mode 

Signal strength along polyline paths can be view and compared in this 
operational mode. 

 

A chart in the main window represents the received signal strength in dBm along a 
polyline path. Primarily first two graphs Prediction a Measurement (red and blue color) 
representing the current polyline path in Prediction and Measurement modes (if 
available) are fixed. The paths can be set using the Set line plot tool in these modes 
(see Ch.7.3). The Measurement graph is not continuos because discrete measurement 
points are considered. 

The first two fixed graphs are automatically updated when the polyline path or the 
current floor is changed. Other stored graphs do not change. 

Arbitrary number of graphs can be viewed and compared in the chart. The graphs 
can represent various paths within the same or different floors, different prediction 
models etc.  

Zooming in the graph is available similarly as in other modes. Using the right 
mouse button the graphs can be moved. 
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8.1 Line Plot Menu 

 Store prediction plot - copies the Prediction graph (first fixed) at the end of 
the list. A text description can be defined. 

 Store measurement plot - copies the Measurement graph (second fixed) at 
the end of the list. A text description can be defined. 

 Reset graph - removes all stored graphs. 

 Export - exports all the graphs into a text file for further processing (e.g. 
using MS Excel). 

8.2 Info Window 

Cursor coordinates 

No information. 

Text description 

No information. 

Legend 

List of the graphs. Visibility of each graph in the 
chart can be switched on/off in the list. 

Quick Tips 

See Ch. 3.2. 
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9 Propagation Prediction Models 

Implemented indoor propagation prediction models are based on the ITU-R P.1238-1 
recommendation, final report of  COST 231 project and results of  research conducted by the I-
Prop authors team. In this chapter, only the user interface for model parameters settings is 
described. 

Propagation of electromagnetic waves inside buildings is a very complicated issue. 
There are various models based on various principles with various requirements for 
input data complexity. In real situation any piece of furniture, open doors and 
windows, moving people, reflections from outside the building and other effects 
influence the signal propagation. It is obvious that the results of any model is just a 
prediction which can failed in some cases. 

(Semi-)empirical models used in I-Prop with only minimum requirements on input 
data can very effectively predict an indoor coverage with the standard deviation 
typically up to around 10 dB. After an optimization of model parameters using test 
measurement data from an analyzed site the deviation can be dramatically reduced. 
The prediction accuracy is reduced for extremely irregular building interiors or 
when improper model parameters are used. When interpreting the prediction 
results these effects should be taken into account. 

Default recommended model parameters for various frequency bands and 
common indoor environments are place in the Models subdirectory (how to load 
the parameters see Ch. 4.3).  

 

Stand-alone software tool is available for automatic model parameters 
optimization based on test measurements. 
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9.1 One Slope Model 

Empirical model that does not require the walls and partitions definition but only 
the environment type. The model is suitable for very fast coverage studies on 
simple bitmaps or drawings 

 

Environment 

 Environment - environment type description. In default recommended 
parameters: 

 Office I. - strong signal attenuation - administration buildings, 
a lot of furniture or hard partitions/walls 

 Office II. - medium signal attenuation - common offices 

 Commercial - slight signal attenuation - large interiors with a 
lot of space (halls, large empty rooms, large offices with soft 
partitions etc.) 

 Corridor - for users in corridors with line of sight to the base 
station. 

 L0 1 - path loss in dB at 1 m distance (intercept).  

 n - power decay index (slope). 

 FAF 1 - Floor Attenuation Factor in dB for signal propagation through a 
single floor. 

 FAF 2 - Floor Attenuation Factor in dB for signal propagation through 
two floors. 
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 FAF m - Floor Attenuation Factor in dB for signal propagation through 
more than two floors. The final attenuation factor is calculated as FAF = 
„FAF 2“ + (n - 2) “FAF m“, where n is a number of floor between the 
base station and the user (n > 2). 

Default environment  

 selected environment (index from the table) for the prediction calculation. 

Offset 

 attenuation offset - the value in dB is added to the prediction in each point. 
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9.2 Multi - Wall Model 

Site specific semi-empirical model, which needs walls definition. The accuracy is 
much better comparing to One-Slope Model. 

 

Loss of walls  

 attenuation factor in dB and a text description for basic wall types. 

Loss at 1m  

 path loss in dB at 1 m distance (intercept). 

Propagation index  

 power decay index (slope). 

Offset 

 attenuation offset - the value in dB is added to the prediction in each point. 

Adjacent floor loss 

 signal propagation loss between adjacent floors. 

Multi-floor param. ‘b’  

 empirical parameter representing multi-floor attenuation linearity. 
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10   How to Create a New Project  

An example of  how to create a new project in few steps is described in this chapter.  
A simple project with only the background bitmap and the One-Slope Model is used. 

Let us assume that a brief study of design possibilities of a picocellular wireless 
system deployment in 5th floor of an office building is needed. Only a simple sketch 
of the 5th floor plan is available. In few minutes simple bitmap of the plan can be 
generated or scanned as a background picture and scale for the coverage analysis: 

 

Creating the floor plan 

 Run I-Prop, choose New from File menu. 

 Select Building… from Project menu (Ctrl-B). The dialog for the basic 
building editing is opened. 

 Press New (left part of the dialog) and input the desired floor number - 5. 
In the floor list a new 5th floor is added. 

 In the right part of the dialog the parameters for the new floor are shown. 
Press Browse in Background bitmap section to load the prepared background 
bitmap. 

 Because the coverage in adjacent floors is interesting for interference issues 
as well, add floors number 4 and 6 using the same New button as above. 
Do not edit their parameters yet. 
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Rescaling the floor plan 

 Press OK to return to the main window into a Floor Plan mode. Select the 
5th floor in the floor selector. 

 Pick the Rescale tool. Using a mouse with the left button pressed draw a line 
over the scale on the background bitmap (when holding Shift only 
horizontal or vertical line is drawn). Than input a real length of the 
distance, e.g. 10 meters. The floor plan is automatically rescaled. 

 Using a right mouse button put the auxiliary coordinate system origin on 
the required point on the bitmap, e.g. on the lower left corner of the floor 
plan. The visibility of the auxiliary origin can be set by View auxiliary [X,Y] 
origin in the View  menu. 

 Start again the Edit Building dialog (Project - Building…menu) and select the 
5th floor in the floor list. 

 In the Background bitmap subsection press the Auto [0,0] button to move the 
background bitmap to the desired position in the coordinate system. Press 
To all in this subsection to copy the bitmap settings to all other floors. 

 In the View subsection press the Auto button to set the viewport for the 
coverage studies (viewport is defined to include the whole bitmap). Press 
To all button in this subsection to copy the settings to all other floors. 

 In the Height subsection set the floor height (including the ceiling thickness) 
to e.g. 4,5 meters. Again use the To all button to copy the information to 
other floors. 

Base stations 

 Return to the main window and select the System Plan mode and the New 
BS tool. 

 Using a mouse put a required base stations on the floor plan and set their 
parameters. 

Coverage analysis 

 In the Model parameters dialog (menu Project - Model parameters…, Ctrl-M) 
choose the One-Slope model, check the Multi-floor propagation and set the 
environment for the One-Slope Model. 

 Return to the main window and switch to the Prediction mode. Run the 
prediction calculation (menu Prediction - Run Building). Then you can switch 
to a desired coverage study (Prediction menu) for all floors. Polyline path can 
be chosen to see the results in the Line Plot mode as well (see Ch. 8). 

For more precise design 

 If a design that is more precise is required, the floor plan should be defined 
in details by its walls. Multi-Wall model can be used then. 
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 If test measurements are available for the site, parameters of the models 
could be optimized for the specific case. 

Examples of projects are placed in the Examples subdirectory. 



 

 

 

 


